
Dashboard Tools and Features with Kyubit Business Intelligence 

www.kyubit.com 

 

 

 

 

 

Dashboard Tools and Features - 

User Manual 

Using dashboard features with Kyubit Business Intelligence 

© 2024, All rights reserved 

 

www.kyubit.com 

 

 

 

 

 



 

 

2 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

Contents 
1. Dashboard features overview ................................................................................................................................ 6 

2. Managing Data Sources ......................................................................................................................................... 7 

2.1. OLAP and SQL server data sources............................................................................................................... 7 

2.2. Set up ODBC data source .............................................................................................................................. 8 

2.3. Set ‘Data Source’ permissions .................................................................................................................... 10 

3. Creating and designing dashboards .................................................................................................................... 11 

3.1. ‘Free Position’ based dashboard layout ..................................................................................................... 11 

3.2. Working with dashboard charts ................................................................................................................. 12 

3.2.1. Add a tile to the dashboard ............................................................................................................... 12 

3.2.2. Remove tile from the dashboard ...................................................................................................... 13 

3.2.3. Rearrange tiles on the dashboard ..................................................................................................... 13 

3.2.4. Configure tile to show visualization .................................................................................................. 13 

3.3. Customize Analysis structure on the chart (Chart Filters) ........................................................................ 19 

3.4. Chart automatic data refresh ..................................................................................................................... 20 

3.5. Open custom URL in a context of chart selection data ............................................................................. 21 

3.6. Open custom URL in the quick frame ........................................................................................................ 22 

3.7. Dashboard title, header and footer ........................................................................................................... 23 

3.8. Manage dashboard area size ...................................................................................................................... 25 

3.9. Dashboard filters panel ............................................................................................................................... 25 

3.10. Rename Dashboard Filter ........................................................................................................................... 26 

3.11. Saving the dashboard .................................................................................................................................. 26 

3.12. Enter and exit ‘Design view’ for the dashboard ........................................................................................ 27 

3.13. URL to access dashboards .......................................................................................................................... 27 

3.14. Dashboard Auto-slicing ............................................................................................................................... 28 

3.15. Dashboard Company Logo Box ................................................................................................................... 29 

4. Configuring dashboard charts ............................................................................................................................. 30 

4.1. Data usage within tiles (Categories and series) ......................................................................................... 30 

4.2. ‘Analysis’ data for the dashboard tiles ....................................................................................................... 30 

4.3. Alternative Measure for analysis data (OLAP or Analytic Model) ............................................................ 35 

4.4. ‘Geo maps’ configuration and usage ......................................................................................................... 36 

4.4.1. ‘Color Gradient’ geo map .................................................................................................................. 36 

4.4.2. ‘Dominant Series’ geo map ............................................................................................................... 37 

4.4.3. ‘Geolocations’ data on geo map ....................................................................................................... 38 

4.4.4. Drill-down geo map data ................................................................................................................... 39 

4.5. ‘Table’ chart visualization ........................................................................................................................... 41 

4.6. Table chart drill-down (Hierarchical display) with analysis options ......................................................... 43 

4.7. ‘Min Y’ and ‘Max Y’ on Line, Spline and Column charts ............................................................................ 44 

4.8. ‘Bubble/Scatter’ chart specifics .................................................................................................................. 45 

4.9. ‘Combo’ chart .............................................................................................................................................. 46 

4.9.1. Delta chart .......................................................................................................................................... 47 



 

 

3 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

4.9.2. Self-Compare Combo chart display ................................................................................................... 48 

4.10. ‘TreeMap’ chart ........................................................................................................................................... 49 

4.11. ‘HeatMap’ chart .......................................................................................................................................... 51 

4.12. ‘Cluster Stack Column’ chart ...................................................................................................................... 53 

4.13. ‘Sunburst Analytics’ on the dashboard ...................................................................................................... 54 

4.14. HTML/Javascript tile .................................................................................................................................... 56 

4.15. ‘Expand View’ of the dashboard chart ....................................................................................................... 57 

4.16. Expand view – Cumulative Filters ............................................................................................................... 58 

4.17. Export Chart as a PNG file ........................................................................................................................... 59 

4.18. ‘MDX query’ data for dashboard tiles ........................................................................................................ 60 

4.19. ‘SQL Queries’ data for dashboard tiles ...................................................................................................... 61 

4.20. ‘Drill-through’ data on the dashboard ....................................................................................................... 62 

4.21. Time Animated Charts ................................................................................................................................ 63 

4.21.1. Animated Bubble Chart ..................................................................................................................... 63 

4.21.2. Animated Bar Chart............................................................................................................................ 66 

4.21.3. Animated Butterfly Chart................................................................................................................... 67 

5. Dashboard layout configuration options ............................................................................................................ 68 

5.1. Color theme palette .................................................................................................................................... 68 

5.2. Manage Color Palettes ................................................................................................................................ 70 

5.3. Single-Color Charts ...................................................................................................................................... 71 

5.4. Define a Color for Specific Series ............................................................................................................... 74 

5.5. Different color for positive and negative values ....................................................................................... 75 

5.6.  Value labels .................................................................................................................................................. 76 

5.7.  Show only selected categories/series ........................................................................................................ 77 

5.8.  Pivot Categories/Series ............................................................................................................................... 77 

5.7.  Show ‘Trend/Average’ Lines ....................................................................................................................... 78 

5.9. Legend display and the position ................................................................................................................. 78 

5.10.  Dashboard tile borders ........................................................................................................................... 79 

5.11. Tiles order on the dashboard ..................................................................................................................... 81 

5.12. Dashboard breadcrumbs ............................................................................................................................ 81 

5.13. Dashboard Mobile view and Embedding Info ........................................................................................... 82 

5.14. Dashboard and chart Info panel ................................................................................................................. 83 

6. Working with KPIs ................................................................................................................................................. 84 

6.1. Designing KPI ............................................................................................................................................... 85 

6.2. Understanding data usage for KPI design .................................................................................................. 87 

6.3. Setting permissions for KPI ......................................................................................................................... 87 

6.4. KPI visualization ........................................................................................................................................... 88 

6.5. Gauge KPI visualization ............................................................................................................................... 88 

6.6. Goal-Meter KPI visualization ....................................................................................................................... 89 

6.7 KPI Alerts ...................................................................................................................................................... 90 

7. Scorecards ............................................................................................................................................................. 91 



 

 

4 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

7.1. Scorecard defined with a SQL query .......................................................................................................... 93 

8. Working with Queries .......................................................................................................................................... 94 

8.1. Creating a Query ......................................................................................................................................... 94 

8.2. Formatting query values ............................................................................................................................. 96 

8.3. Impersonate query execution .................................................................................................................... 98 

8.4. ‘User Properties’ as query additional filters .............................................................................................. 98 

8.5. Query caching ........................................................................................................................................... 100 

8.6. Setting Query permissions ....................................................................................................................... 100 

9. Dashboard Analytic Features ............................................................................................................................ 101 

9.1. OLAP/Analytic Model Filters .................................................................................................................... 101 

9.2. Quick Slicers .............................................................................................................................................. 103 

9.2.1. OLAP/Analytic Model filters inheritance to child dashboards ...................................................... 105 

9.3. SQL data filtering ...................................................................................................................................... 106 

9.3.1. Creating SQL queries with ‘Input Parameters’ .............................................................................. 109 

9.4. Exclude dashboard chart from the filtering ............................................................................................ 110 

9.5. Chart drill-down, drill-through actions on the dashboard ..................................................................... 111 

9.5  ‘User Properties’ as Dashboard filters .................................................................................................... 111 

9.6. Define dashboard filter values using URL query string .......................................................................... 113 

9.7. Dashboard filters configuration ............................................................................................................... 114 

9.8. End-User actions on the dashboard chart .............................................................................................. 115 

9.9. Use a chart as ‘Slicer’ chart ...................................................................................................................... 116 

9.10. ‘Quick Explore’ dashboard analytic feature ............................................................................................ 117 

9.11. Compare Analysis ..................................................................................................................................... 119 

9.11 Master-Detail Report ..................................................................................................................................... 121 

10. Dashboard descriptive text features ........................................................................................................... 122 

10.1. ‘Dynamic Text’ on the dashboard ........................................................................................................... 122 

10.2. HTML support for dashboard descriptive text ....................................................................................... 124 

11. Exporting dashboard to a PDF file................................................................................................................ 125 

11.1. Include Company Logo image in the exported PDF ............................................................................... 127 

12. Folders and dashboards access permissions ............................................................................................... 128 

12.1. Setting object permissions ....................................................................................................................... 128 

13. Subscriptions ................................................................................................................................................. 130 

13.1. My subscriptions ...................................................................................................................................... 130 

13.2. Subscriptions within the dashboard ........................................................................................................ 131 

13.3. Subscription details .................................................................................................................................. 132 

13.4. Contacts and Contact Groups .................................................................................................................. 134 

13.5. Recurring subscriptions ........................................................................................................................... 135 

13.6. Send subscriptions conditionally ............................................................................................................. 135 

13.7. Personalized Circular Subscriptions ........................................................................................................ 136 

14. Mobile Dashboards View .............................................................................................................................. 137 

14.1. Connect Mobile Device to Kyubit Business Intelligence ........................................................................ 137 



 

 

5 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

12.2. OLAP Analysis on Mobile Dashboards ......................................................................................................... 138 

15. Multipage Reports ........................................................................................................................................ 140 

16. Dashboard Data Slideshow........................................................................................................................... 141 

17. Integrate dashboards with other web applications and sites .................................................................... 142 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

6 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

1. Dashboard features overview 
Kyubit dashboard features are designed to present data from OLAP/SQL databases and CSV files, to give simple 

and comprehensive feedback about important business values and trends. While creating a dashboard, the user 

has various visual options to present data most efficiently regarding the nature of data and business 

requirements. Easy drag-and-drop features make dashboard design and creation simple and straightforward 

task, which is easy to adopt by any user. To retrieve data for dashboard chart elements, existing analyses or 

SQL/MDX queries could be created. Dashboards could be also delivered to users using Mobile devices, 

Scheduled Subscriptions or as Embedded Analytics integrated within any HTML page. To work with dashboard 

features, select ‘Dashboards’ tab on the top of the Kyubit Business Intelligence application. 
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2. Managing Data Sources 
All data for dashboard elements is retrieved from data sources that contain interesting business data for the 

presentation and metrics. Once created, data sources are used from multiple queries and analysis. To see all 

existing data sources in Kyubit Business Intelligence, open Dashboards -> Data Source (tab). 

It is possible to create OLAP, SQL, ODBC data sources. (‘Analytic Models’ as a separate data source could be 

created using any of the above-mentioned data sources.) 

 

 

 

 

2.1. OLAP and SQL server data sources 
Create a new OLAP or SQL data source to be used for queries and analyses. Once created ‘Data source’ can be 

used on multiple objects in Kyubit Business Intelligence application and by the users who are given permission to 

work with. 

OLAP Data Source 
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SQL Server Data Source 

 

 

 

For both, OLAP and SQL data sources, custom connection strings could be set and connection could be tested 

before the data source is saved. 

 

 

2.2. Set up ODBC data source 
To create an ODBC data source, first configure an ODBC connection on your machine. 
For example, create an ODBC connection to Excel or Access files on your system. 
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‘Data Source Name’ that is used for the ODBC connection on the operating system level, use to create new Data 

Source in Kyubit BI application. 

 

 

 

To set up an ODBC data source for MS Office applications, which are available only for 32-bit ODBC 

configuration, it is also required to configure Kyubit application to work in 32-bit mode. Open IIS Manager -> 

Application pools -> “KyubitAnalysisPool” - > Advanced Settings and set “Enable 32-bit application” to “True”. 
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2.3. Set ‘Data Source’ permissions 
If the ‘Data Source’ should be visible to other users, click on the ‘Permissions’ options in the upper-right corner 

and add appropriate Active Directory/Windows or Kyubit users and groups to have ‘Read’ or ‘Read/Write’ 

permissions or set Unrestricted access to created Data Source. (See chapter 7.1. for more details) 

 

 

 

If a user does not have ‘Read’ permission on the data source, he will not be able to create new queries and 

analyses based on same ‘Data Source’, but he will be able to open dashboard with queries and analyses based on 

the same ‘Data Source’. 
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3. Creating and designing dashboards 
All users with access to Kyubit Business Intelligence application could create new dashboards. To start creation 

of new dashboard, click ‘Create New Dashboard’ button on the dashboards view. New Dashboard will be opened 

in a design view, ready to be designed and configured. 

 

3.1. ‘Free Position’ based dashboard layout 
The dashboard consists of one area where dashboard tiles (charts) are positioned in any preferred way. Drag-

and-drop any visualization tile from the charts toolbar on the dashboard and set its position and size on the 

dashboard 'Area'. To resize a tile, click on the resizing handle (arrow) on the tile lower-right side. While moving 

around and resizing a particular tile, element size indicator is displayed on the lower-right side of tile element, 

indicating tile size in pixels, so a dashboard designer could easily compare and organize content on the 

dashboard. Tiles are moved and resized by 10px step, making it easy to align among other dashboard tiles. 

Dashboard 'Area' is always positioned centrally on the dashboard page and at any time set 'Area' size with the 

button on the right. Arranged positions and sizes of dashboard tiles are respected while exporting dashboard to 

PDF (Simple Export). To remove tile from the dashboard, click on the tile edit and trash icon. 
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3.2. Working with dashboard charts 
On every dashboard, user can choose to add more than 20 different charts and visualizations (tiles) that present 

some kind of data visualization. On the dashboard toolbar on the left, visualization (chart) types are presented 

with descriptive icons. On a dashboard tile, visualization type can be changed on Tile -> design -> ‘Chart Type’ 

attribute. 

 

 

▪ Line chart 
▪ Column chart 
▪ Column chart stacked 
▪ Column chart 100% 
▪ Area chart 
▪ Area chart stacked 
▪ Area chart 100% 
▪ Pie chart 
▪ Doughnut 
▪ Bubble/Scatter chart 
▪ Table 
▪ KPI  
▪ Gauge meter 
▪ List 
▪ Geo Map 
▪ Card 
▪ Small Card 
▪ Combo chart 
▪ Tree Map chart 
▪ Goal Meter 
▪ HeatMap chart 

 
 

3.2.1. Add a tile to the dashboard 
To add tile to dashboard, drag-and-drop preferred tile type (visualization) from toolbar on the left to the 

dashboard area on the right. 
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3.2.2. Remove tile from the dashboard 
To remove tile (delete) from the dashboard, click on the dashboard tile edit icon and choose ‘Delete’ button. 

 

3.2.3. Rearrange tiles on the dashboard 
At any time in the design view, tiles could be rearranged or moved to any position. Simply drag-and-drop tiles to 

preferred location or resize dashboard tile with resize handle on the lower right corner of the tile. 

 

 

3.2.4. Configure tile to show visualization 
When moving mouse over tile (while dashboard is in design mode) ‘Pen’ icon is displayed, which allows user to 

click and open tile configuration form. 
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Enter dashboard general information: like ‘Title’, ‘Description’ and, if you like, set ‘Child dashboard’ that will be 

opened as a more detailed view of the same data, enabling users to have ‘drill-down’ experience while using 

dashboards. 

 

 

 

‘Data’ is second tab on the tile form, where data for visualization will be defined. 
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‘Chart Data’ is input where user selects existing Analysis or Query (TSQL or MDX) previously created in Kyubit BI 

application to retrieve data and show in this tile visualization (‘Line chart’ in this case). Existing Analysis means 

that analysis is created in ‘Analysis’ part of Kyubit Business Intelligence application (OLAP or ‘Analytic Model’ 

analysis) and that current user has at least permissions ‘Read’ permission on the folder containing the analysis. 

Existing Query (TSQL or MDX) means, that query is previously created in ‘Dashboards’ part of Kyubit Business 

Intelligence application and current user has at least ‘Read’ permissions on the folder containing the analysis. If 

the Query which user requires still does not exists in the application, a user could click on ‘New’ button 

immediately from tile form and create new MDX or TSQL query to be used on this tile chart/visualization. To 

select an existing analysis or query, click on the ‘Select’ button and selection form of existing Analyses and 

Queries will be displayed. Quickly find required analysis/query for chart visualization using the Search option or 

filtering by the particular data source or Recently Used view. 

 

Analysis selection… 
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Query selection… 

 

 

 

All analysis created within Kyubit BI application for which current user has at least ‘Read’ permission are 

displayed in selection form. Displayed list could be filtered by ‘Data Source’ for environments with many 

analyses. Same principles work for Query selection. 

After Analysis/Query is selected, click on ‘Test’ button in tile form to test visualization with selected 

analysis/query data. 

In tile configuration form, a user still can change tile (visualization) type, if concludes that given data is more 

appropriate to show with different chart type.  

Finally, click ‘OK’ in tile configuration form and tile will present data within the dashboard area. 
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Using the same principles configure other tiles to appropriate visualize other relevant business data on the 

dashboard… 
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3.3. Customize Analysis structure on the chart (Chart Filters) 
If the chart is based on the analysis (OLAP or Analytic Model), you can set alternative measures and dimension 

for this chart and void having to create a separate analysis if the existing structure do not provide required 

results. 

Also, here you can define chart filters that will be used only by this chart. 
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3.4. Chart automatic data refresh 
Every dashboard tile could be configured to automatically refresh data in a defined period of time in minutes. 

Only tiles with defined ‘Tile Refresh’ attribute will be refreshed with a new data. 

 

 

 

If option ‘Show last refresh time’ is checked, dashboard tile will display time passed since last data refresh in the 

dashboard. 
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3.5. Open custom URL in a context of chart selection data 
To open custom URL when a user clicks on a dashboard chart, set ‘Open custom URL’ attribute of the tile.  

 

 

 

 

By clicking on a dashboard tile element, new browser tab will be opened with URL that is defined, but also with 

an additional URL query string that is created within the context of point/bar/wedge which is actually 

clicked/selected. 

For example: 

http://www.adventureworks.com?Details=1&pointName=United States&pointUnique=[Geography].[Geography 

Hierarchy].[Region Country Name].&[United States] 

If the dashboard contains added OLAP filters, they will be also part of the create URL in a separate parameter. 

If the data source is based on SQL data, the added query string will be based category id defined in the query 

object. 

If the chart is based on SQL query. Custom link URL will open “Category name” defined in query or “Category ID” 

if it is defined within query column that represents “Category ID”. 

 

 

 

 



 

 

22 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

Custom URL Placeholders for OLAP data: 

To fine-tune what you would like to get in the final URL related to the chart click event, use placeholders to 

include specific elements about the selected chart segment to the final URL opening external content. 

 

Available placeholders are: 

{CategoryDimensionLevelName} - Level name of the selected chart point on the category axis. 

{CategoryDimensionLevelUniqueName} - Level unique name of the selected chart point on the category axis. 

{CategoryMemberUniqueName} - Member unique name of the selected chart point on the category axis. 

{CategoryMemberName} - Member name of the selected chart point on the category axis. 

{SeriesDimensionLevelName} - Level name of the selected chart point on the series axis. 

{SeriesMemberUniqueName} - Member unique name of the selected chart point on the series axis. 

{SeriesMemberName} - Member name of the selected chart point on the series axis. 

{MeasureName} - Measure Name of the selected chart point. 

{PointValue} - Value of the selected chart point. 

 

Custom URL Placeholders example: 

https://www.kyubit.com?categoryName={CategoryDimensionLevelName}&measureName={MeasureName}&co

untry={CategoryMemberName}&value={PointValue}  

Opens final URL on the chart click: 

https://www.kyubit.com/?categoryName=Country&measureName=Internet%20Order%20Count&country=Austr

alia&value=1.934 

 

3.6. Open custom URL in the quick frame 
 

Set a dashboard chart to open a quick custom URL frame at the moment the chart point is clicked within the 

same dashboard page. Opening a custom URL in a frame is much faster (and sometimes more convenient) 

compared to then opening a custom URL in a new browser tab. 

Add dimension of the frame before the URL to direct opening URL in the frame within the same page. 

For example: [500,400] https://www.kyubit.com 

 

 

https://www.kyubit.com/
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3.7. Dashboard title, header and footer 
While in the dashboard ‘design view’ click on the ‘Details’ button to define dashboard ‘Title’, ‘Description’ on the 

‘General’ tab. 

 

 



 

 

24 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

On the ‘Header/Footer’ tab set appropriately dashboard header and/or footer and its alignments text and 

alignments… 
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3.8. Manage dashboard area size 
To change size (width) of the dashboard area, in the dashboard design mode select one of the predefined values 

on the Size menu. 

 

 

3.9. Dashboard filters panel 
Filters panel area is on the right side of the dashboard, where a dashboard designer could set filters that would 

apply to all dashboard charts. Click the filter icon to toggle the display of the dashboard panel. If saved with 

hidden filters panel, the dashboard will open every time for end-user with hidden filters panel. To resize the 

width of the filters panel, drag the left edge (handle) to the required position, which will be saved for the future 

dashboard openings. 
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3.10. Rename Dashboard Filter 
Sometimes, dashboard filter title based on selected dimension level is not completely appropriate for a given 

dashboard. To customize dashboard filter title, click on the edit filter button and while in the ‘simple’ filter view, 

click on the title and set any other title for this dashboard filter. 

 

 

3.11. Saving the dashboard 
All work in design mode needs to be saved with the ‘Save’ button in the upper-right area of the dashboard. With 

‘Save’ action all tiles, their settings and arrangements are saved for future dashboard openings. 
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Saved dashboard immediately appears in ‘My Dashboards’ list, ready to be used. 

 

 

 

 

3.12. Enter and exit ‘Design view’ for the dashboard 
After the existing dashboard is opened, design options are disabled and only users with ‘Read/Write’ permissions 

on the dashboard could choose to continue design work on the dashboard (or with Administrator rights). While 

the user is not in a ‘Design’ view, the dashboard data, tiles and all dashboard arrangements are not available to 

change. ‘Design’ mode is just slightly visually different than ‘Regular’ view, so at the end of design, the user 

should ‘Exit design’ to see exactly how other users will see the dashboard while consuming prepared dashboard 

details. 

 

3.13. URL to access dashboards 
Kyubit Business Intelligence offers more than one way to access dashboards and particular dashboard. 

To access available dashboards, use: 

http://yoursite/dashboards 

or 

http://yoursite/forms/dashboards.aspx 

 

To access single dashboard, use: 

http://yoursite/dashboard/123 

or 

http://yoursite/forms/dashboard.aspx?dashboardID=123 
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3.14. Dashboard Auto-slicing 
A dashboard with auto-slicing sets any chart to be used as a slicer for other chart data without opting for 'Use as 

slicer' on the individual chart. As soon as the dashboard is opened, selecting any chart segment/bar/slice will 

slice other chart data with the selection. 

 

1) Open Dashboard > Design > Details and optionally set Auto-slicing. 

 

 

2) Slice the dashboard with one click on any chart. 
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3.15.  Dashboard Company Logo Box 
A logo box is displayed on the dashboards and reports when using the 'Company' or 'Enterprise' edition license. 

The logo box could be hidden or set to an alternative image. When using the multitenant license a logo box 

could display the different logo for each tenant in the application. 

 

1) To display the image of your company/organization, replace the CompanyLogoBox.png image with 

yours (same or similar dimensions) in the Kyubit “WhiteLabel” folder. 

 

 

2) To hide Logo box, set “LogoBox” value to “0” in Kyubit web.config file (C:\Program 

Files\Kyubit\BusinessIntelligence) 
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4. Configuring dashboard charts  
After adopting general dashboard design and construction details, this chapter describes how to create all visual 

details on the dashboard elements (tiles) to best reflect business data situations and give end-users clear and 

easy-to-understand status of business important values and indicators. The dashboard could display 2 groups of 

the visual elements, the chart and the Key Performance Indicators (KPIs). 

Charts: 

▪ Line/Spline chart, most appropriate to show time-related data. 

▪ Column chart, most appropriate to show multiple series of data. 

▪ Pie/Doughnut chart, most appropriate to show single data with one-series data. 

▪ List, most appropriate to show an ordered list with names and numbers. 

▪ Geo Map, most appropriate to show data related to geography (world countries and regions) 

▪ Bubble/Scatter chart, most appropriate to show several measures for the same item 

▪ Waterfall chart, most appropriate to display cumulative changes 

▪ Area chart 

▪ Stacked Column chart 

▪ Column chart 100% 

▪ Stacked Area chart 

▪ Area chart 100% 

▪ Combo chart, most appropriate to compare values from 2 different sets of data 

▪ HeatMap chart, most appropriate to visually identify patterns and highlights in your data 

▪ Card/Small Card, quick insight into important values 

▪ TreeMap chart, most appropriate to identify proportions 

▪ Table chart, show data in rows and columns with various visual features 

 

KPIs: 

▪ Standard KPI visualization shows KPI icon, KPI value, last change and optionally a small line chart that 

describes KPI values in the past to the current one. 

▪ Gauge Meter, is KPI presentation with Gauge visualization, giving feeling to end user, how much current 

value is successful. 

▪ Goal Meter presents KPI with circle visualization that describes expectation and result. 

 

 

4.1. Data usage within tiles (Categories and series) 
After drag-and-drop a tile to the dashboard, click on edit tile (Pen icon), choose dashboard title and select or 

create analysis/query that will feed current tile with data we would like to visualize.  

Essentially, each dashboard tile is receiving data in the format of categories and series. Column and line charts 

could accept many series of values, list chart accepts one or two series of values, while Pie chart, KPI and Gauge 

meter accept only one series of values to visualize the data. 

 

 

4.2. ‘Analysis’ data for the dashboard tiles 
Analysis created in Kyubit Business Intelligence could be used as data for dashboard tile. Analysis rows presents 

are categories while columns in analysis present series. In this example, ‘Country’ presents categories, while 

‘(Product) Subcategories’ present series of values (‘Mountain bikes’ and ‘Road Bikes’). 
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When this analysis data is defined for dashboard tile, it will be presented on these different ways using 

different visualizations (charts). 

 

Column chart … 
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Line chart… 

 

 
 

 

Pie Chart … 

 

 
 

(Note: pie chart shows only first series) 
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List chart … 

 

 
 

Geo map … 

 

 
 

Data Table … 
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TreeMap chart … 

 

 

HeatMap chart … 

 

 

 

 

 



 

 

35 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

4.3. Alternative Measure for analysis data (OLAP or Analytic Model) 
If the chart is based on analysis data (OLAP/Analytic Model) a user can choose different (alternative) measure 

than already existing in the analysis to display a chart or a KPI for other measures, not having to create a new 

separate analysis for that purpose. 

 

 

 

With alternative measures feature, create a single analysis and many charts based on the same analysis and 

different measures. 
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4.4. ‘Geo maps’ configuration and usage 
‘Geo Maps’ displays data related to world countries, regions and locations (cities) in a geographical context. Geo 

maps are designed for quick visual perception of the data on the geographical map. To correctly relate retrieved 

data to ‘countries’ or ‘regions’, data results should have the first column value in a row that match 

country/region name on the Geo-map, while the second column value presents the value that should be 

visualized for the country/region. If you are not sure what are the names, simply load the map in the dashboard 

with no data and move the mouse over the regions which will display a tooltip with the country/region name. 

Also, in the Admin section, Geo Locations it is easy to browse all maps available in the application, to see how 

they look and what region certain map covers. 

Kyubit Business Intelligence application supports Geo maps for all continents and major countries. List of 

available maps is expanded with almost every new version of Kyubit BI application. 

Check end section of this document for a detailed list of values that are supported when supplying data for Geo 

maps for various countries and regions. 

 

4.4.1. ‘Color Gradient’ geo map 
Presents values from analysis or query results as a single-color gradient on the selected geo map. A simple way 

to visualize the influence of the selected values geographically. 

Values … 

 

Color gradient Geo Map … 
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4.4.2. ‘Dominant Series’ geo map 
In this mode each country/region is displayed with the separate color, depending on the series with the highest 

value. This is a convenient way to quickly identify which series of values is most influential in the specific 

country/region. For example, election results. To enable this option, open Tile -> Edit -> Options -> (check) 

Dominant Series Colors. 

Values … 

 

Dominant Series geo map … 
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4.4.3. ‘Geolocations’ data on geo map 
To display values related to cities or any other geographic locations related to your data, use data set 'Markers' 

defined in Tile -> Edit -> Options -> Markers section. Kyubit with setup automatically deploys 7300 largest cities 

in the world. If your data includes places and geolocation not included in the initial set of 7300 biggest cities, you 

can easily add locations in 'Geo Location Management' application section (explained in the ‘Kyubit 

Administration and Configuration’ user manual document). 

Geolocations could be visualized with data from analysis or query using one or two measures. In this example, 

each measure 'Purchase Price' and 'Tax Amount' will be rendered using Geolocation to visually identify the 

impact of both values. 

Values … 

 

 

Configuration … 
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Geo map chart results … 

 

 

Please, contact support@kyubit.com for additional maps. 

4.4.4. Drill-down geo map data 
If Geo map uses OLAP/Analytic Model data, Geo map tile has the option to drill-down geo map areas to its child 

geo map representation. Continents are drill-down to countries, countries are drill down to regions. Analyzing 

geodata on the dashboard becomes perceptual and comprehensive. Within few clicks users isolates and 

observes data in the geographical form, that could be easily exported to PDF file or share with other users. 

mailto:support@kyubit.com
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With every new version of Kyubit Business Intelligence application, more countries and regions are available to 

use by Geo Maps feature on the dashboards. All continents and largest countries with their regions are available, 

but also Kyubit will provide Geo maps for other countries and regions of your interest. Please, contact us for 

more details when country or region of your interest will be available. 
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4.5. ‘Table’ chart visualization 
‘Table’ is a specific dashboard tile type that presents measures, categories and series with rows and columns and 

it is not limited to small datasets. If visualization displays a large number of columns and rows scrollbars will 

become visible to navigate through data. ‘Table’ can show all the records from the analysis, MDX or SQL queries 

with value formatting defined on analysis or query level. 

Often usage of data in the form of Table/Grid as most appropriate data insight in many cases, Kyubit Dashboards 

ensures with additional visualization features that will contribute to simplicity, elegance and focus on relevant 

details when 'Table' is rendered within the dashboard. 

‘Table’ chart simply renders values from query or analysis with an unlimited number of columns and rows and 

appropriate scrollbars if required. This way any data could be displayed on the dashboard without limitations. 

‘Table’ chart is the only chart that could display ‘Any data’ query type, which does not have to include numeric 

values like other charts and could display any data type. 

‘Table’ chart has numerous options to customize its appearance and focus user to relevant points on the chart. 

Use 'Grid Lines' options to draw horizontal or full grid lines on the table. Set the table chart height, font-size, row 

height and column width for the table or set for each column individually background-color, fore-color, text-style 

and alignment to get the most appropriate look of the 'Table' chart on the dashboard. Dashboard 'Table' chart 

can render any data types from analyses or queries with option to display 'Value Bars' for numeric data types. All 

defined visual appearance options are also rendered while exporting dashboard to PDF file. If dashboard 'Table' 

is rendering analysis containing KPI definitions, KPI icons will be displayed automatically. 
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‘Table’ chart samples… 

 

 

 

 

 

 

 

 

 

 



 

 

43 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

4.6. Table chart drill-down (Hierarchical display) with analysis options 
Dashboard Table chart can display drilled-down levels on the category axis, if the table data is based on created 

analysis (OLAP or Analytic Model). With this feature, it is easy to create analysis with preferred expanded 

(drilled-down) items, which will be represented the same way while displayed on the dashboard. 

 

 

 

Dashboard creator has the option to enable this dashboard feature with Tile > Options > Allow Analytics. When 

set to 'Read' table chart will display expanded levels the same way as on the analysis. When set to 'Analyze' table 

chart will display expanded levels, but also end-user has options to add new levels or remove/change existing 

levels to get analysis of its preference while working with the table chart not leaving the dashboard.  

When opened it will present a drilled-down view as saved with the grid analysis feature. Optionally, add or 

remove dimension levels to further analyze OLAP or Analytic Model data, up to 4 levels of data drill-down. 
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4.7. ‘Min Y’ and ‘Max Y’ on Line, Spline and Column charts 
All dashboard charts automatically calculate what is the Y-axis, min and max values to show. Line, Spline and 

Column charts have the option to manually configure which segments on the Y axis you prefer to show. Default 

chart visualization for next chart. 

 

 

 

…could be configured to show more precise segment of Y axis. 

 

 

By setting Min Y and Max Y value user actually zoom area of values that are of the current interest. 
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4.8. ‘Bubble/Scatter’ chart specifics 
For an analysis that contains 2 or 3 measures, ‘Bubble/Scatter chart’ can visualize all measures, first as the 

position on X-axis, second as the position on Y-axis, while the third measure is rendered as a bubble size, to get 

quick insight to related data impact. 

 

2 or 3 measure values … 

 

 

Measure values rendered on Bubble/Scatter chart … 
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4.9. ‘Combo’ chart 
Use ‘Combo’ chart to visualize and compare two data sets (analysis or query) on the same dashboard chart. 

After selecting base data set and ‘Combo’ chart, additional ‘Options’ on the tile configuration enables you to 

choose secondary data set to compare over first selected. Choose any combination of ‘Line chart’ or ‘Column 

chart’ for the base and compared data set. Secondary data set values could be displayed on same Y-axis as first 

data set or on a separate Y-axis. 

 

Configure data set to compare … 

 

 

Compared sets on the Combo chart … 
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4.9.1. Delta chart 
When using a ‘Combo’ chart or ‘Compare Analysis’ feature, there is an option to display a Delta chart above 

compared sets that will visualize differences by each item in the compared sets. 

 

Delta chart displays the difference for the items (values). ‘Green’ positive and ‘Red’ negative differences. Combo 

chart displayed as a combination of ‘Column chart’ and ‘Line chart’. 

 

 

Delta chart displays cumulative differences for the items (cumulative). ‘Green’ positive and ‘Red’ negative 

differences. Combo chart displayed as a combination of ‘Column chart’ and ‘Column chart’. 
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4.9.2. Self-Compare Combo chart display 
Compare each data item with the previous item in a dataset using a Combo chart and a single dataset (query or 

analysis). When 'Delta chart' is set to a single dataset, the delta chart values will visualize every item compared 

to the previous visualizing its mutual difference. 

 

1) Add the combo chart to the dashboard. Set chart data to any analysis or a query. In the tile > Options 

set 'Delta Chart' to 'Values' or 'Cumulative'. The delta chart will display the item difference compared with the 

previous item in the data set. 
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4.10. ‘TreeMap’ chart 
'TreeMap' chart that is used to quickly gain a perception of the values and its mutual proportions. There are 

several options to configure about 'TreeMap' behavior, such as color for 'high' and 'low' values and option to 

render size based on the first series of values and color based on the second series, separately. 

 

 

 

Edit colors for ‘High’ and ‘Low’ values of the ‘TreeMap’ chart in the dashboard tile visual options. 
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TreeMap chart could be configured to display size of items based on the first series of values while displaying 

color based on the second series of values from the data chart is based upon. If the data is based upon 

OLAP/Analytic Model data, at any time click on the particular item to use analytic actions, such as drill-down, 

drill-through, etc. 
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4.11. ‘HeatMap’ chart 
HeatMap chart displays values as colors for each item in the data set, presenting impact of each item compared 

to other items. HeatMap visualization beside default value-color range, supports additional ranges with custom 

colors, providing beautiful and quick visual analytic insights to rendered data.  

 

 

 

Default color range is defined by the default color pallet on the dashboard/chart. Additional value-color ranges 

are defined in visual options on the HeatMap chart. HeatMap chart could contain many value-color ranges. 

Manually added value-color ranges have rendering priority compared to default value-color range. 
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HeatMap Relative Color Range 

Previously, it was possible to define a color range with fixed values. The version 5.3 provides relative definitions 

of color ranges that would be applied for the whole data set or individual columns or rows. For example, the 

color range would be applied for the top 30% items in each column individually. 

 

 

 

Define relative color range with MIN | MAX COLUMNS | ROWS PERCENT definition. For example, MIN ROWS 0% 

- MIN ROWS 20% (lowest 20% in each row), MAX 100% - MAX 90% (highest 10% in the whole data set), MAX 

COLUMNS 70% - MAX COLUMNS 100% (highest 30% in each column). 
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4.12. ‘Cluster Stack Column’ chart 
‘Cluster Stack Column’ chart is available only for a SQL query results rendering. Within each category item cluster 

name should be specified that will be used to separate column in clusters. A SQL query should be constructed on 

such way that category item (the first column in the SQL query results), contains cluster name and category item 

name separated by the hashtag (cluster#item). 

 

Example of SQL query with defined cluster groups … 

 

 

Rendered ‘Cluster Stack Column’ chart … 
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4.13. ‘Sunburst Analytics’ on the dashboard 
The Sunburst chart displays multiple levels of data analysis (OLAP/Analytic Model) on the same chart, with the 

option to further drill-down the data, change dimension levels and provide data visualizations in multiple 

analytic steps. Initial structure (expanded members) of the Sunburst visualization is identical to the saved 

analysis that is used for the visualization, while it takes only a click to drill-down any member on the chart to the 

next analytic level. Furthermore, a user can change levels of the Sunburst chart to a different dimension and 

analyze data in any other way, making this visualization a convenient tool for data exploration and discovery. 

 

Create Analysis (OLAP or Analytic Model) in which required dimension members will be expanded and save the 

analysis. 

 

 

 

On the dashboard add ‘Sunburst’ visualization and connect with the created analysis. The Sunburst visualization 

requires more space on the dashboard than other chart visualizations to present data as it can show 4 levels of 

dimension members. The Sunburst visualization will immediately display dimension members the same way they 

were expanded/collapsed in the analysis. 
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End-users on the dashboard can click on any sunburst wedge to expand sunburst segments that are not initially 

expanded. Mouse over any sunburst wedge to display information about the current wedge in the center of the 

sunburst visualization. 

Right click on the sunburst wedge to get the menu to additionally change drilling dimension for any wedge on 

any level. 
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4.14. HTML/Javascript tile 
Enter any HTML/Javascript in a dashboard tile that could display any custom data, information or provide any 

additional insights related to your business requirements. HTML tile is saved and opened with other dashboard 

charts. While exporting dashboard to PDF file, HTML/Javascript tile will not be included. 

 

 

 

Set dashboard tile HTML/Javascript that will display custom functionality in the dashboard. This is a unique way 

to embed custom insights and features into the dashboard page. 
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4.15. ‘Expand View’ of the dashboard chart 
Data visualization on dashboard tile in certain moments is not large enough, for example, for presentation 

purposes, when focus is on a particular chart. 

All tiles have ‘Magnify’ icon that enlarges chart visualization. 

 

 

 

Enlarge action transforms view to single tile visualization on the screen. 

 

 

Enlarged view also includes analytic actions (if data is from OLAP/Analytic Model data source), export to 

Excel/PDF file and option to continue the analysis in the full analysis view. 
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4.16. Expand view – Cumulative Filters 
On the dashboard expanded chart view, it is possible to open Cumulative Filters display (Upper right) to show all 

filters that are currently applied by this chart display. Chart filters could be defined on the belonging analysis, 

dashboards, could be result of another chart slicer or it could be defined on the chart itself (Custom Tab). Here 

they are all listed and also all exported to Excel or PDF file while exporting from this view. 
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4.17. Export Chart as a PNG file 
Open a dashboard chart in the 'Expanded view' and set custom font and size. Download the chart as PNG image 

to include it in external content, presentation, or a document. 

 

1) Set chart display to another font and font size. 

 

 

 

2) Download the chart as a PNG file. 
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4.18. ‘MDX query’ data for dashboard tiles 
While creating the MDX query for the dashboard tiles, values on the column axis present series, while values on 

the rows axis present categories. (More information about queries, see ‘6. Working with queries section’) 

 

 

 

Example of ‘Column chart’ using above query data… 
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4.19. ‘SQL Queries’ data for dashboard tiles 
While creating SQL query for the dashboard tiles, values on the column axis present series, while values on the 

rows axis present categories. (More information about queries, see ‘6. Working with queries section’) 

 

 

 

Example of ‘Pie chart’ using above query data… 
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4.20. ‘Drill-through’ data on the dashboard 
Dashboard option to display initially drill-trough results in the moment of dashboard opening respecting existing 

dashboard filters. Usually, drill-through results contain specific leaf-level details from OLAP/analytic model and 

its convenient to present with the Table chart. For example, a dashboard can initially display a list of names, 

emails, phone numbers and dates related to the sales of the current month from our data OLAP/analytic model, 

by adding a Table chart that is connected to existing drill-through results. Drill-through results are displayed only 

if any filter is set for the dashboard. Drill-through results react on selected dashboard filters or ‘Use chart slicer’ 

feature. This way user can quickly get drill-through data for any selection/members on the dashboard. 

Because drill-through results can contain very large portions of data that would take serious time to display, 

initially, drill-though results display the first 100 rows of data. The idea of drill-through results on the dashboard 

is to present the most important/relevant data on the dashboard in the form of drill-through. To change the 

number of initially displayed rows for the dashboard, change the ‘MaxRowsDrillthroughDashboard’ config value 

in the application ‘web.config’ file. 

To connect dashboard ‘Table’ chart with existing drill-through action, open chart edit form and ‘Chart Data’ 

input and navigate to ‘Drill-through’ tab to select one of the available drill-through actions defined in the Kyubit 

application. The same principle works both for OLAP and Analytic Models analysis. 

 

 

 

When any filter is selected for the dashboard display, ‘Table’ chart will display drill-through results … 
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4.21. Time Animated Charts 
A set of charts that display data changes with time. The time axis on the bottom presents the time period in 

which data has changed. While the chart is in play mode, the animation transforms chart elements to illustrate 

the changing of values through the time period. At any time, pause the animation or click on the time axis to 

jump to any particular time period to visualize its data. Right-click on the chart to open a special set of options 

for the time-animated chart. All charts could display data on a linear or logarithmic axis. All time-animated charts 

could be exported and used as standalone HTML files that could be opened in the browser outside the Kyubit 

application or integrated into another website. 

 

4.21.1. Animated Bubble Chart 
Displays changes of 2 or 3 measures for given elements (dimension members) in time. At any time pause and 

zoom into the chart values. While observing the values for a particular element, click on it and display the 

‘History line’ that will show all previous values for the same elements presented with additional (historic) 

bubbles and the line chart. Use the ‘Compare Analysis’ to compare values between two periods. Use the 

‘Progress Analysis’ to display what elements are best performers in some time period. 
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Animated Bubble Chart expects a certain structure of the related analysis. Related analysis has to be based on 

the 2 or 3 measures. It should refer to one or two category levels and time periods added to the series axis of 

the analysis. 

 

 

Example 1 – Single category level 
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Example 2 – Two category levels. In this scenario, the first level presents the grouping of elements on the 

animated bubble chart that is displayed with a particular group color indicated on the chart legend. 
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4.21.2. Animated Bar Chart 
Animated Bar Chart presents the ‘Race to the top’ animated chart by single measure. The user observes who are 

the top performers for any time period and how the top performers are changing are in time. 

 

 

Expected Analysis has to include a single measure, single category level and time periods on the series axis. 

 



 

 

67 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

4.21.3. Animated Butterfly Chart 
A bi-directional bar chart compares two group of items by single measure in the time. 

 

The expected analysis structure for the animated butterfly chart is the following: single measure, 2 category 

levels (first level is grouping of items, the second level presents actual items on the chart), time dimension 

period on the series axis. 
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5. Dashboard layout configuration options 
Dashboard and rendered visualizations could be additionally configured to display additional visual and data 

options. Each dashboard tile has visualization options that are easy to configure to maximize the perception of 

related data. 

 

5.1. Color theme palette  
Set the dashboard color theme palette that will be applied to all dashboard tiles or set color palette for 

particular tile visualization. By default, all dashboard tiles inherit the color theme from the dashboard (General 

Settings) which is by default 'Standard' color theme. While in the dashboard 'Design view' user can opt color 

theme for the whole dashboard or set individual tiles color theme. Kyubit product delivers 5 color theme 

palettes (Standard, Warm, Cold, Strong, Gray), while other color palettes could be added and managed by the 

administrator in Kyubit > Admin > Colors section. 

1) To change color pallet for whole dashboard, select ‘dashboard design mode’ -> ‘details’ -> ‘general’ 

-> select one of available pallets. 

 

2) To change color pallet, select ‘dashboard design mode’ -> ‘tile edit’ -> ‘options’ –> select one of 

available pallets. 

 

 

 

 

‘Standard’ color pallet … 
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‘Warm’ color pallet … 

 

 

 

‘Cold’ color pallet … 
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5.2. Manage Color Palettes 
Kyubit Admin role has a privilege to manage Color Palettes in Kyubit > Admin application section. It is possible to 

edit existing or add new Color Palettes. 

 

 

A Color Palette can contain any number of colors. If data contains more series than available colors, colors are 

repeated to visualize all series. 
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5.3. Single-Color Charts 
An effective way to present important charts that will outstand on the dashboard with the 'Single-Color' style 

(Color Palettes). In this way, you can design a chart background with a specific color, while chart elements are 

presented with shades of white. The chart looks outstanding among other charts with a flat outlook. 

 

      

 

To set dashboard chart for a single-color mode, open Tile > Edit > Options and under ‘Color Palettes’ choose a 

single color that is displayed below all color palettes. You can pick from a few predefined colors or choose any 

custom color to be used with a Single-Color display mode. 
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All charts support Single-Color display mode… 
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5.4. Define a Color for Specific Series 
Set a color rule for a specific series on the dashboard, that will be followed by all charts on the dashboard. When 

you have multiple charts on the dashboard that contains the same items, naturally end-user would expect the 

same series of values to be visually presented with the same color on all the charts. 

 

 

 

To define a series color, open the dashboard in the Design model > Details > General > Member Colors. In this 

form add/edit any color preferred for the series.  

 



 

 

75 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

5.5. Different color for positive and negative values 
If the chart contains single series of values, positive and negative values are displayed in different colors. The 

first color of the color palette is used to display positive values, while the second color of the palette is used to 

display a negative value. Create a custom color palette to match your color requirements. 
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5.6.  Value labels 
All chart visualizations have an option to display 'Value Labels', which means that value for particular chart 

segment/point will be visible without having to move the mouse over it, which is particularly practical while 

exporting dashboard to PDF file or watching the Dashboard tiles on the slide show. 

 

To set ‘Value Label’ options, follow 
these steps: 
 

1) Select ‘Dashboard Design 
mode’ -> ‘Tile edit’ -> ‘options’  
 

2) Choose ‘All’ to set ‘Value 
Labels’ for all values on the 
chart. 

 
3) Choose ‘Top N’ to set ‘Value 

Labels’ for highest values on 
the chart. Use ‘Top N (Short)’ 
option to display short values 
and save space on the chart. 

 
4) Choose ‘Value Label – 

Categories’ to display ‘Value 
Labels’ only for selected 
categories. 

 
5) Choose ‘Value Label – Series’ 

to display ‘Value Labels’ only 
for selected series. 
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5.7.  Show only selected categories/series 
OLAP analysis, MDX and SQL queries return data structures that consist of categories and series to be visualized 

on the dashboard charts. In dashboard 'Design View' user can select to show only particular categories or series 

and narrow focus to the data of current interest. 

 

1) Select ‘Dashboard design mode’ -> ‘Tile edit’ -> ‘Options’  

2) Choose ‘All’ to set ‘Value Labels’ for all values on the chart. 

3) Choose ‘Specific Categories’ to select categories that will be displayed 

4) Choose ‘Specific Series to select categories that will be displayed 

 

 

To select only items that will not be displayed. Select Items and add exclamation as the first character. (For 

example, “!Australia,France”. In this case all countries will be displayed except Australia and France. 

 

5.8.  Pivot Categories/Series 
With one click on the tile 'Options' switch position of categories and series and turn around the impression of 

the data on the chart visualization. A useful feature when returned data from OLAP and SQL sources require 

different axis orientation of rows and columns we would like to use on the chart. 

 

1) Select ‘Dashboard design mode’ -> ‘Tile edit’ -> ‘Options’  

2) Mark ‘Pivot’ checkbox, categories and series will switch positions 
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5.7.  Show ‘Trend/Average’ Lines 
Select series of the data to calculate and display 'Trend Line' or ‘Average Line’ on supported chart types (Line 

Chart, Column Chart, Area Chart and Bubble Chart). 'Trend/Average Line' series are displayed in the same color 

as selected series of data. 'Trend Line' is based on the Linear Trend equation. 

1) Select ‘Dashboard design mode’ -> ‘Tile edit’ -> ‘Options’  

2) Select ‘Series Trend Line’ or ‘Series Average Line’ pickers to select series for which you would like to 

display the Trend or Average line. 

 

 

  
 

5.9. Legend display and the position 
Customize the appearance of the chart legend on each individual tile on the dashboard. Legend position could 

be set in tiles 'Options' and could be set to 'Top', 'Right' and 'None' position value. 

 

1) Select ‘Dashboard design mode’ -> ‘Tile edit’ -> ‘Options’  

2) Select ‘Legend’ dropdown and select one of available values.  
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5.10.  Dashboard tile borders 
The dashboard tile border is displayed with Shadow Square edges by default. In 'Design View' dashboard 'Details' 

-> 'General' settings tile border could be set to Shadow Square, Square, Round or None borders. 

 

1) Select ‘Dashboard design mode’ -> ‘Details’ -> ‘General’  

2) Select ‘Tile Border’ dropdown and select one of available values.  

 

Shadow Square … 

 

 

Shadow Round … 
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Square (border) … 

 

 

 

None (border) … 
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5.11. Tiles order on the dashboard 
When designing a dashboard, a user can choose tiles order that will be applied when the dashboard is used in 

Mobile View, PDF Export and Slides view. Because the dashboard itself is constructed with a free-to-resize-and-

position tiles approach, it is not easy to determine the exact order of the tiles.  

 

To set exact order of the tiles on the dashboard, go to dashboard Design mode > Details > Tiles Order and move 

tile up and down to reach preferred order. 

 

 

 

 

5.12. Dashboard breadcrumbs 
Each dashboard above title contains a link to the home page and the link to the folder from which the dashboard 

is opened. To disable breadcrumbs, display on the whole application level, set "HideDashboardBreadcrumb" in 

the web.config file to "1". 
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5.13. Dashboard Mobile view and Embedding Info 
While working with the dashboard in desktop (standard) view, using the Options menu a user can get a preview 

(and idea) how to use and display the same dashboard using mobile devices (and how it will look) or embed to 

another HTML page. 

 

Quick demo how dashboard charts would be displayed using the mobile view. 

 

 

A wizard on how to quickly embed the same dashboard to any other HTML page with customizable attributes. 
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5.14. Dashboard and chart Info panel 
Dashboards and charts support adding the text/HTML in the header which could additionally describe dashboard 

or chart content. If the dashboard Header – alignment is set to value Information, provided text will not be 

displayed in the header, but will be available on the dashboards or chart Info icon. When the icon is clicked, the 

content will be opened in the windows above the dashboard content. 
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6. Working with KPIs 
Once created, the KPI could be re-used on many dashboards with the respect to defined permissions on the KPI. 

All available KPIs for the current user are visible in ‘Dashboards’ -> ‘KPI’ section of the Kyubit Business 

Intelligence application. 

 

 

 

When one of the dashboard tiles should display KPI, one must first be defined in the Kyubit Business Intelligence 

application to be used on the dashboard itself. It could be right away created while in dashboard ‘Design’ view, 

without leaving working dashboard. 
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6.1. Designing KPI 
‘KPI Design’ form offers everything on one place to create KPI in Kyubit Business Intelligence application. 

 

 

 

▪ ‘KPI Name’, defines full name of the KPI in the system. 

▪ ‘KPI Short Name’, will be used on places (mobile device), where space is limited 

▪ ‘KPI Description’, simply describe KPI meaning for other users. 

▪ ‘Success Model’, defines if higher values are more successful (Higher is better), lower values are more 

successful (lower is better) or values closer to target are more successful (Middle-Range Success). 

▪ ‘KPI Value’ is actual value that is tested for KPI success. Could be configured as ‘Fixed numeric value’ or 

value from a ‘Query/Analysis’. 

▪ ‘Success threshold’, defines limit above KPI status is consider as ‘Success’ and marked with green arrow 

icon. Could be configured as ‘Fixed numeric value’ or value from a ‘Query/Analysis’. 

▪ ‘Fail threshold’, defines limit bellow KPI status is considered as ‘Failed’ and marked with red arrow icon. 

Could be configured as ‘Fixed numeric value’ or value from a ‘Query/Analysis’. 

▪ If ‘KPI value’ is between ‘Success’ and ‘Fail’ limit, KPI is in the ‘Even’ status and marked with yellow 

circle. 

▪ ‘Last change as percentage’, defines if last change will be displayed as percentage or regular delta 

value. 

▪ ‘Show KPI values line chart’, defined if line chart will be visible next to KPI to reflect changing of data 

through time, up to last (current) value. KPI data feed is based on series of values (first series of 

analysis/query) and last value in series is considered as current value to be evaluated for KPI, previous 

values are considered as historic and could be displayed as list chart next to KPI indicator. 

When all inputs are selected, click on ‘Test KPI’ to immediately display KPI visualization and perhaps make 

correction, before it is closed. 
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Testing KPI definition … 
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6.2. Understanding data usage for KPI design 
The data to display KPI comes from ‘Analysis’ (existing analysis within Kyubit Business Intelligence application), 

‘MDX Query’ or ‘TSQL Query’. Value to be evaluated as relevant for KPI is the first value in the first series of 

values retrieved from analysis or query. All other values after the first value are considered as a historic 

supplement of values and are used to describe trend and last value change (delta). 

 

 

KPI value is the first value in the first series of query values, other values are used to draw line chart and the 

second value is used to show ‘last value change’. 

 

Same principles are used if data is retrieved from ‘Analysis’ or ‘MDX query’. 

 

 

6.3. Setting permissions for KPI 
If KPI should be visible to other users, click on the ‘Permissions’ options in the upper-right corner and add 

appropriate Active Directory or Kyubit users and groups to have ‘Read’ or ‘Read/Write’ permissions or set 

unrestricted access to created KPI. (See chapter 7.1. for more details) 
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6.4. KPI visualization 
Default KPI visualization on the dashboard includes KPI status icon (that quickly describes current KPI status), KPI 

current value, last values change and last changes of values displayed as small line chart or column chart. 

 

 

 

 

6.5. Gauge KPI visualization 
Gauge visualization displays KPI current status with additional insight on how much it takes to meet success or 

fail threshold that is indicated by the pointer on the gauge. Various visualizations options are included to design 

gauge that suits best to your visualization requirements, which includes colors, various pointer types, display of 

mini charts, last value indicator and additional color meter on the top. All visualization options could be selected 

at the tile visualization options tab. 

 

 



 

 

89 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

6.6. Goal-Meter KPI visualization  
Another way of KPI status display with circle metric showing how much it takes until KPI reach its goal with the 

additional red arc that displays also failure area of the KPI. Simply add Goal-Meter to the dashboard and attach 

existing KPI to display its status. 
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6.7 KPI Alerts 
Any user can create an alert for any available KPI and receive an email notification when KPI reaches one or 

more required statuses. It presents a quick and simple way for a user to be notified of important value 

thresholds being reached with a flexible monitoring and notifying frequency. Just click on the dashboard KPI and 

create a new Alert. 

 

1) Select any available KPI on the dashboard and create a new alert to be notified of the relevant KPI 

status.  

 

 

2) The alert form defines the status or statuses that will trigger the alert. Also, a list of email addresses 

that will receive this alert is available to provide for this alert. 
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7. Scorecards 
Organize multiple KPIs to a list that presents the status of all KPIs, targets, indicators, goal percentage on one 

place on the dashboard. Easy create Scorecard list in the KPI & Scorecard section of the application and assign 

appropriate permissions. 

 

 

 

Pick from the list of existing KPIs and arrange order you prefer. 
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The appearance of the Scorecard on the dashboard depends on the dashboard column width and/or defined 

columns of Scorecard to display. If there is the place, more details about Scorecard KPIs will be displayed (if not 

configured manually). 

 

Scorecard with less space on the dashboard: 

 

 

Scorecard with more space on the dashboard: 

 

 

If KPI has ‘Short Name’ defined, it will be used to display KPI name on the Scorecard. If not, KPI default name will 

be used. 
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7.1. Scorecard defined with a SQL query 
An alternative to creating KPIs one by one and adding to a scorecard is creating a list of values and thresholds 

with SQL query results (if applicable in your environment). Such query results are quickly rendered on the 

Scorecard visualization on the dashboard. 

 

1) Create a query that includes columns 'KPIName', 'KPIValue', 'KPIValueText', 'Success', 'Fail' and 'Model' 

and save it as query type = 'Scorecard data'. While adding a scorecard visualization on the chart, this 

query will be available as a data source for the scorecard. 

 

 

 

2) SQL query-based scorecard is quickly rendered on the dashboard. The ideal way to present a larger set 

of performance items. 
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8. Working with Queries 
Data for dashboard tiles comes from ‘Analysis’ (existing analysis in Kyubit Business Intelligence) or from 

MDX/TSQL queries. This chapter describes ‘Query’ creation and some important properties of queries. 

All queries available to the current user are displayed in Dashboards -> Queries section of Kyubit Business 

Intelligence. Two query views are available: ‘All available Queries’ (considering query permissions) and all queries 

‘Created by me’. 

 

 

 

Queries could be MDX queries for OLAP data source or SQL queries for SQL Server or ODBC Data sources that 

accept SQL query data requests.  

 

 

8.1. Creating a Query 
All Kyubit Business Intelligence users could create the query using query design form and Data sources for which 

they are given permissions.  

‘Query Type’ has two options: 

a) Data Table. This form of the query consists of Categories and Series. The first column defines 

Categories, while other columns present Series and must contain numeric values. This form of the 

query is used to present/visualize data on the dashboard. 

 

b) Filter Values. This form of the query is only used to list values that would be used as ‘drop down’ values 

for SQL filtering on the dashboard. Check section 8.2 ‘SQL Dashboard filtering’ for more details on this 

topic. 

 

c) Any data. This form of the query consists of Categories and Series. The first column defines Categories, 

while other columns present Series with any values (does not have to be numeric). 
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For each query, ‘Data source’ has to be selected. If the data source is OLAP database, MDX query will be 

expected and if the data source is SQL database, SQL query will be expected. 

Both MDX and TSQL queries always expect the first column as category column with any type of data, while all 

subsequent columns are considered a series of values and must be of numeric type. 

Both MDX and TSQL queries expect at least one series of values (one category and one series columns of data). 
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8.2. Formatting query values 
For each column of the query data results, “Format string” definition could be defined to present the data with 

an appropriate formatting to the end-users. 

 

 

 

Click on the column ‘Format string’ option and fill-in measure format string for the selected column. 
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To get required number formatting output for data usage. 

 

 

Examples of “Format string” for number 123456.789 

$#,#.##    => $123.456,78 

€#,#.##    => €123.456,78 

#.## USD    => 123456,78 USD 

#,#.#    => 123.456,7 

#,#.###    =>  123.456,789 

#,#.###0    => 123.456,7890 

#,#  => 123.456 

 

Same measure unit will be displayed wherever this query is used on any of the dashboard visual elements (tiles). 
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8.3. Impersonate query execution 
By default, the query will be executed in the context of the current user. If for any reason the data source needs 

to be accessed with different user credentials. Impersonate user credentials could be defined on ‘Impersonate’ 

tab on the query design form. 

 

 

 

8.4. ‘User Properties’ as query additional filters 
The query could be filtered using current user properties to show the data of interest for the current user. User 

properties are Login Name, Real Name of current user or custom created user properties that could be assigned 

and changed by the Kyubit administrator. 

To create and manage user properties, Kyubit Administrator should navigate to Administration -> ‘Users and 

Admins’, create new custom user properties and click on each user to assign his custom property values. 
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‘User Properties’ could be used to filter Analyses, Queries and Dashboards. 

To add ‘User Property’ as query, add ‘User Property’ name with double square brackets to your SQL or MDX 

query. ([[UserPropertyName]]) 
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8.5. Query caching 
The query results could be cached to avoid production data sources from constant query execution and save 

hardware processing time and usage. Imagine hundreds of users opening the same dashboard and for each 

dashboard opening, the query to underlying data sources executes each time the dashboard is opened. That 

kind of query execution is unnecessary in most scenarios and caching queries for a certain amount of time is 

perfectly good for the most dashboard scenarios. To set the caching on a certain query, open the query design 

form and on ‘Caching’ tab set number of minutes for which the query results will be cached.  

 

 

 

 

The query results are cached on two levels. First, the query results are cached on ASP.NET level within Kyubit 

Business Intelligence application memory. If for any reason, IIS is restarted or application is recycled within IIS 

execution, the query results are stored in the Kyubit Business Intelligence internal database. In both cases, 

cached query results will be expired after a defined amount of time and the original data source will be queried 

afterward. 

 

8.6. Setting Query permissions 
If the query object should be visible to other users, click on the ‘Permissions’ options in the upper-right corner 

and add appropriate Active Directory/Kyubit users and groups to have ‘Read’ or ‘Read/Write’ permissions or set 

unrestricted access to the created Query. (See chapter 7.1. for more details) 
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9. Dashboard Analytic Features 
 

9.1. OLAP/Analytic Model Filters 
All data on dashboards that are based on the OLAP data source or Analytic Models could be manipulated with 

data filters that could be added in the design or production time. If a filter is added in the design time, it will be 

part of the dashboard whenever the dashboard is opened. Also, users who are not dashboard designers, but 

only use the dashboard, could also add the dashboard filter that will be only a temporary supplement to the 

dashboard, while the dashboard is opened. 

 

 

 

Adding a slicer for certain OLAP/Analytic Model data source will automatically filter (refresh) all tiles based on 

the same data source with the slicer dimension members. Slicers could be additionally changed, reordered and 

removed to provide fine analysis tool while exploring OLAP/Analytic Model data. 
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Filter dialog box in advanced view with options to search for dimension members, apply ‘User Properties’ or ‘Time 

Intelligence’ 

 

 

State of the filters panel (opened/closed) and its width (drag left-right to resize) is saved with the dashboard and 

opened next time the way it is saved. 
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9.2. Quick Slicers 
Every dashboard filter added to the dashboard filters panel could be opened as a ‘Quick Slicer’, which would 

display dimension members ready for rapid selection changes by clicking on the particular members. In this way 

quickly change the whole dashboard data view that would be sliced immediately after every click on the ‘Quick 

Slicers’. Holding down the control key would add a clicked member to the selection. After the ‘Quick Slicers’ is 

displayed, hold with the mouse button on the slicer header and move the slicer position to any preferred place 

on the dashboard. Also, click on the slicer resize handle (lower-right) and resize the slicer as preferred. The 

selection, position, and size will be saved along with the dashboard and later opened in the exact same state. 

 

Click on the filter icon on the dashboard panel to toggle the display of the ‘Quick slicer’ related to this filter. 
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A sample dashboard layout with quick filters and hidden filters panel. 
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9.2.1. OLAP/Analytic Model filters inheritance to child dashboards 
The dashboard could contain tiles that have ‘Child dashboard’ configured to open as a separate dashboard in the 

new browser tab. If the parent dashboard has filters defined, opening ‘Child dashboard’ will pass (inherit) all 

OLAP/Analytic Model filters from parent to child dashboard. 

 

 

 

Child dashboard has gray OLAP filters that are inherited by opening from parent dashboard. 
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9.3. SQL data filtering 
Data on the dashboard could also be filtered by adding SQL data filters. For this concept to work, SQL Queries 

with ‘Input parameters’ have to be created that requires some basic SQL knowledge (see 8.2.1 Creating SQL 

queries with ‘Input parameters’). Once you create the dashboard chart that is based on the SQL query with 

‘Input parameters’ you can add SQL filters that would filter/slice data on the dashboard. SQL Filters could be 

static ‘Numeric’ and ‘Date Time’ input fields, or they could be a drop-down list of values that comes from SQL 

queries defined as ‘Query Type’ = ‘Filter values’.  

While selecting the query for visualization on the dashboard, a user can see if created query accepts ‘Input 

parameter’. 

 

 

 

 

After adding a query to a dashboard visualization in the design mode, moving mouse over tile title will display 

‘Input parameters’ this visualization accepts. Now, this dashboard tile visualization is ready to be filtered. 
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Adding a filter … 

 

 

Adding a SQL filter will show a dialog to choose another query that return drop-down list of values that would be 

used to filter data or to select static input field that would be used for filtering. 'Number' or 'Date Time' filter 

type. 
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(Selecting query for a drop-down list of values for filtering. A filter will be applied only to visualizations with same 

‘Input parameter’ name as defined of query filter.) 

 

 

 

(Select input field that will be used for SQL filtering. Filter will be applied only to visualizations with same ‘Input 

parameter’ name as defined for ‘Output parameter’ on this input field).   

 

 

(Added SQL filters appear on the slicer panel with the option to change filter values) 

 

Applying SQL filters immediately show sliced data for the dashboard tiles with ‘Input parameters’ that match 

added filter ‘Output parameter’ name. 
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9.3.1. Creating SQL queries with ‘Input Parameters’ 
To create SQL query with ‘Input Parameters’ some basic SQL knowledge is required for the query text 

manipulation.  For example, the following query… 

 

 

select top 200 DimProduct.EnglishProductName, DimGeography.EnglishCountryRegionName, s.SalesAmount, 

s.ShipDate  

from [dbo].[FactInternetSales] s 

left join DimCustomer on s.CustomerKey = DimCustomer.CustomerKey 

left join DimGeography on DimCustomer.GeographyKey = DimGeography.GeographyKey 

left join DimProduct on DimProduct.ProductKey = s.ProductKey 

 

 

… returns values without the option to be filtered in the dashboard.  
Now, we would like to have the ability to filter products based on several filter inputs. To add filter parameter 
input open curly brackets, add the name of the filter parameter that must start with @, then add ‘colon’ 
character following with the SQL expression that will be used if the filter parameter value is actually supplied. 
 

 
select top 200 DimProduct.EnglishProductName, DimGeography.EnglishCountryRegionName, s.SalesAmount, 
s.ShipDate  
from [dbo].[FactInternetSales] s 
left join DimCustomer on s.CustomerKey = DimCustomer.CustomerKey 
left join DimGeography on DimCustomer.GeographyKey = DimGeography.GeographyKey 
left join DimProduct on DimProduct.ProductKey = s.ProductKey 
where 1=1 
 
{@productName: and EnglishProductName like '%@productName%'} 
{@shipDate: and s.ShipDate < '@shipDate' } 
{@country: and EnglishCountryRegionName in (@country)} 
{@salesAmount: and s.SalesAmount > @salesAmount} 
 
order by s.SalesOrderNumber desc 
 

 
 
This semantic ensures that SQL query will be correctly executed if no filter parameter values are supplied and 

also if any number of filter parameter values is supplied. 

If @productName parameter is supplied, SQL expression will be included in the query: 

and EnglishProductName like '%@productName%'  (where @productName will be replaced with the actual filter 

parameter value). 

 

Filter parameters provided on this way could be used on the same way for any technology supporting SQL 

language to retrieve the data (MS SQL server or any other data source supporting ODBC query calls). 
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9.4. Exclude dashboard chart from the filtering 
By default, all dashboard tiles accept filters defined on the dashboard level. Each dashboard tile can be excluded 

from accepting filters added to the dashboard, which will be ignored in such case. 
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9.5. Chart drill-down, drill-through actions on the dashboard 
All dashboard tiles based on the OLAP/Analytic Model data source could be drilled-down, sliced or drilled-

through in place within the dashboard. Right click on the OLAP/Analytic Model dashboard chart and selected one 

of the available analytic actions. 

 

 

 

 

9.5  ‘User Properties’ as Dashboard filters 
The dashboard could be filtered using current user properties to show the data of interest for the current user. 

User properties are Login Name, Real Name of current user or custom created user properties that could be 

assigned and changed by the Kyubit administrator. 

To create and manage user properties, Kyubit Administrator should navigate to Administration -> ‘Users and 

Admins’, create new custom user properties and click on each user to assign his custom property values. 
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‘User Properties’ could be used to filter Analyses, Queries and Dashboards. 

To add ‘User Property’ to OLAP/Analytic Model analysis as a filter, while in a filter dialog form, click on the ‘User 

Property’ icon on the upper right and choose one of the existing User Properties. More values under the same 

property should be delimited with a semicolon (;). 

 

 

 

Every time the user opens an analysis, ‘User Property’ value will be resolved and used to filter analysis data using 

the current user property value. 
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9.6. Define dashboard filter values using URL query string 
If the dashboard contains SQL or OLAP filters, filter values could be set using URL opening the dashboard. This 

gives great flexibility how data will be sliced and manage dashboard data scope outside Kyubit application. In this 

example, we added the filter with title ‘Customer Geography’ which is identified with parameter ID = 

‘[Customer].[Customer Geography]’. In order to supply the value for this filter using URL, we add the member 

unique name for the ‘France’ member -> [Customer].[Customer Geography].[Country].&[France] … 

@[Customer].[Customer Geography]=[Customer].[Customer Geography].[Country].%26[France] 

… to dashboard URL. Note that ‘&’ character is replaced by %26 HTML escape code for ampersand character. If 

the filter parameter requires more values, separate them with (;) the semicolon. 

@[Customer].[Customer Geography]=[Customer].[Customer Geography].[Country].%26[France]; 

[Customer].[Customer Geography].[Country].%26[Germany] 

… creating final URL … 

http://localhost:85/Forms/Dashboard.aspx?DashboardID=3028&@[Customer].[Customer 

Geography]=[Customer].[Customer Geography].[Country].%26[France];[Customer].[Customer 

Geography].[Country].%26[Germany] 

 

URL filters applied … 
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9.7. Dashboard filters configuration 
‘Automatic Filtering Configuration’ is the default way of handling the dashboard filters. For OLAP/Analytic Model 

data, this means, when the dashboard filter is added, it would automatically be applied on all dashboard tiles 

that are based on the same OLAP/Analytic Model data source. For SQL data-based tiles, this means that filter 

would be automatically applied to all queries based upon the same ‘Input parameter’. 

‘Explicit Filtering Configuration’ is the process in which a dashboard designer could select for each dashboard tile 

which dashboard filters it will use when retrieving data from data sources. On this way, a dashboard designer 

can fine tune, how filters will be implemented for each tile on the dashboard. For example, a dashboard tile 

based on the OLAP/Analytic Model data could accept filter values that are based on some other OLAP/Analytic 

Model data source. 
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9.8. End-User actions on the dashboard chart 
After the dashboard is rendered in the production usage to end-users, there are several options a user can 

choose to additionally arrange and visually analyze data. Right-click on the dashboard tile to show main user 

actions, such are ‘Refresh’ tile data, change ‘Chart Type’, pivot tile data category and series values for the tile 

with ‘Pivot Chart’ action, show ‘Values Labels’ on the chart with additional selection on how many items labels 

would be displayed, set temporary ‘Aggregate’ (SUM or AVG) value that could be used to compare with the 

existing tile chart values or click on ‘Use as Slicer’ option to set tile chart to act as a dashboard slicer. 

 

Right-click on the chart legend shows additional actions that could be used on a particular series of values on the 

chart. Such is ‘Sorting’ of the data on the chart, display ‘Top X’ items on the chart, 

 

  … or toggle display of ‘Trend’ or ‘Average’ line on the chart and ‘Value Labels’ for a particular series of values on 

the chart. 



 

 

116 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

 

 

 

9.9. Use a chart as ‘Slicer’ chart 
From version 3.7 of Kyubit Business Intelligence app, end-user while working on the dashboard can choose 

several chart types and turn them into dashboard slicers. Chart types ‘Pie Chart’, ‘Doughnut Chart’, ‘Column 

Chart’, ‘Line Chart’ and ‘TreeMap Chart’ could be toggled to ‘Use as slicer’ mode with a single click of end-user if 

data chart is based upon OLAP/Analytic Model data. At the same time, more than one chart on the dashboard 

could be set to work in a ‘Slicer’ mode, giving many possibilities to slice and analyze data of interest on the 

dashboard. 
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9.10. ‘Quick Explore’ dashboard analytic feature 
‘Quick Explore’ feature is designed to get quick insight about specific chart segment related to some other 

dimension. For example, if chart displays the product sales values, with ‘Quick explore’ feature a user could get 

quick insight how specific product sales was in the past, by using ‘Quick explore’ with Time dimension. Quick 

explore dimension and Quick explore chart type could be defined on the dashboard chart during design time or 

production time by the designer or end-user. 

Once ‘Quick Explore’ feature is set, it is enough to click on the any chart segment to get small chart visualization 

of the selected member using other dimension. 

 

‘Quick Explore’ display additional dimension in a small separate window … 

 

 

For example, when a user clicks on 'Jacksonville' city, 'Quick Explore' window will pop-up showing Jacksonville 

sales data by the products. Same could be applied for any measure and using various charts. 'Quick Explore' 

chart could be further drilled-down to a particular dimension or displayed as an enlarged chart in the full screen 

mode. 
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Click on the Queensland/Bachelors column open ‘Quick Explore’ values for the same item over the months … 

 

 

Click on the Male/June chart point opens ‘Quick Explore’ window with ‘Occupation’ data for the same point … 
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9.11. Compare Analysis 
When observing a dashboard chart based on OLAP or Analytic Model analysis, a user has an option to compare 

currently displayed data with the same data when applied using a different set of filters. Compare form shows 

filters applied to the original data-set and the compare data-set. On the same chart, both sets of data are 

displayed for easy comparison. 

 

 

 

For example, if the original chart display sold items over the year, a user can quickly compare the same set with 

sold items from the previous year, gender female from Europe, for instance. 
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When using the 'Compare Analysis' a user could use all features that applies to 'Combo chart', choosing display 

of Line/Column chart combination, using delta chart to display differences, etc. 

 

 

 

Base and compare filter sets are displayed as two items in the chart legend. 
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9.11 Master-Detail Report 
Open a report analysis in the context of particular chart point on the dashboard. Analysis in a Report View will be 

opened for that particular point, passing a point member and other dashboard filter members to the report 

filtering. The ideal way for end-users to observe master-detail insights from a dashboard chart (master view) to a 

particular analysis for a particular selected value on the chart (details view). Select a ‘Report’ in Tile > Options > 

Master-Detail Report field to be used with this feature. 

 

 

 

Right-click on any point on the dashboard chart. If defined, Master-Detail Report option will be visible. (Use Tile > 

Options to define Master-Detail Report). Report View will open for a clicked point on the dashboard and also 

passing existing dashboard filters. 
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10. Dashboard descriptive text features 
The dashboard and its charts contain features to include text that would additionally describe the content for 

the end-user. Dashboard itself contains header and footer text that should generally describe dashboard overall 

content, while individual dashboard charts could have chart description text that explains the data on the 

particular dashboard chart. 

 

 

 

10.1. ‘Dynamic Text’ on the dashboard 
The text of the Dashboard can contain dynamic values from previously created analysis and queries. For 

example, now you can quickly set description text explaining which is the most sold product this year using the 

words. 

 



 

 

123 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

‘Dynamic Text’ picker icon ({}) suggests that this text input could contain dynamic values that are result of 

existing query/analysis execution. First cell in the query/analysis will be taken as relevant and its data will be 

inserted in the existing text input on the position as specified. Dynamic text placeholder that consist of double 

curly brackets will be replaced by the value from query or analysis. Dashboard designer could manually set 

dynamic text by adding query/analysis ID into double curly brackets ( for example, {{A101}} for analysis with ID 

101 or {{Q202}} for the query with ID of 202) or he could click on the ‘Dynamic Text’ picker icon ({}), which will 

open dialog to search and select existing query or analysis and its ID will be embedded to existing text at the 

precise position where cursor was positioned at the time picker was selected. 

‘Dynamic Text’ with first item name from query or analysis is defined with ID inside curly brackets.  

For example, {{A101}} 

‘Dynamic Text’ with first item value from query or analysis is defined with ID inside curly brackets with hashtag 

(#) after ID number. 

For example, {{A101#}} 
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10.2. HTML support for dashboard descriptive text 
The text of Dashboard Header/Footer and Tile Description can contain HTML, which is a convenient way to 

provide enhanced text for end-users but also to add a custom link or similar. Inside dashboard header/footer or 

tile description simply enter HTML text, that will be rendered on the dashboard. This feature should not be used 

to add some complex HTML to text descriptions. While exporting dashboard to PDF, plain text (without HTML) 

will be used. 

 

 

Rendered dashboard chart with HTML in the description text … 
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11. Exporting dashboard to a PDF file 
A user can export complete dashboard or particular dashboard chart to the PDF file at any time. PDF export 

features include Simple and Detailed dashboard export and additional options for end-user to select PDF 

document settings. 

Simple export … 

 

 

Simple export PDF file … 
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A ‘Simple’ dashboard export, creates PDF file that contains all the charts on the single page. If dashboard 

contains ‘Table’ charts, those are rendered on the subsequent pages, because it is not possible to render many 

rows and columns on the single page. 

A ‘Detailed’ dashboard export created PDF file that contains each dashboard chart on a separate page. First page 

is dashboard title and index of dashboard charts. User can opt to export charts with values, in which case below 

every chart there will be table of chart values used to render visualization. 

 

 

 

Rendered ‘Detailed’ PDF export of the dashboard … 
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11.1. Include Company Logo image in the exported PDF 
Set your company logo image to be visible in the exported dashboard PDF header. This option is available to 

Kyubit instances with registered ‘Company Edition’ license or ‘Enterprise Edition’ license. 

 

 

 

 

To setup company logo image, navigate to C:\Program Files\Kyubit\BusinessIntelligence\WhiteLabel folder and 

replace CompanyLogo.png with the image of your preference. Make sure the image is of the same size 400px x 

200px. 

Note: Even if the image is located in the WhiteLabel folder, this feature is not directly related to “White Label” 

feature of Kyubit BI application that allows to customize logo on the complete Kyubit application. 
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12. Folders and dashboards access permissions 
To group more dashboards into a logical group that shares same user permissions, folders could be created to 

contain any number of dashboards. When created, dashboard by default is located in ‘My Dashboards’ folder, 

visible only to the dashboard creator. At any time, user can share the dashboard with other users by moving 

dashboard to folder that is shared with other users. 

 

 

 

 

To create a new folder, click on the button ‘Create New Folder’, fill-in the folder title and click save. New folder 

will appear in the list of folders. New folder is by default visible only to the folder creator and administrators. To 

give other people access to the folder, open the same folder (Edit option) and select ‘Permissions’ in the upper-

right corner. 

 

 

12.1. Setting object permissions 
To set permissions for any Kyubit Business Intelligence object, click on the ‘Permissions’ option in the upper-right 

corner of the form and edit object permission. 
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Search for Active Directory/Windows/Kyubit users and groups to set the appropriate permissions. (depending on 

which authentication is configured for Kyubit application) 

Read/Write permission gives full rights to the user on the folder and all dashboards within that folder. 

Read permission gives the right to see the folder and open all dashboards within that folder. No changes are 

allowed. 

By setting permissions to ‘Everyone’ (unrestricted) gives (Read or Read/Write) permission to any user that is 

trying to access the folder and all dashboards within that folder. 
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13. Subscriptions 
An Important aspect of Kyubit Business Intelligence dashboards usage is to deliver dashboards to the users using 

email subscriptions which contain dashboard data in the form of HTML with embedded dashboard images or 

attached PDF document with dashboard details. Every user of the Kyubit Business Intelligence with at least 

‘Read’ permission has privileges to make a subscription on a dashboard and receive the dashboard on the email 

within scheduled time of delivery. To create subscriptions, a user needs to update his ‘email address’ and 

‘credentials’ in the user settings form (upper left icon in the ‘Home’ page). 

 

13.1. My subscriptions 
Every user can see all his own subscriptions (Analysis and Dashboards) in the Kyubit Business Intelligence 

application -> Dashboards section, where all his subscriptions could be managed. 
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13.2. Subscriptions within the dashboard 
When a user opens certain dashboard, he can immediately see if he already has some subscriptions created on 

the same dashboard. 

 

By clicking on “Subscribe” link, form with existing subscriptions of the current user will be displayed with the 

option to create a new subscription, edit or delete existing. 
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13.3. Subscription details 
There are several subscription settings that could impact the way users are receiving subscriptions. 
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• Subscription title sets the name that will appear when delivering the dashboard/analysis inside the 

email message. 

• Subscription item selects Kyubit Business Intelligence content (Analysis or Dashboard) to deliver within 

the subscription. The user can subscribe to all content with at least ‘Read’ permission. 

• Occurs, defines the scheduled time to deliver the subscription. There are three different time 

scheduling categories: 

o Weekly, set the weekdays to deliver the subscription 

o Monthly, set the month days to deliver the subscription 

o Once, set a single day to deliver the subscription 

• Time sets the time within a day to deliver the subscription 

• Recipients, set the contacts, contact groups and email addresses that will be used to send subscriptions 

• Include, type of delivered content 

o Link to Kyubit Business Intelligence dashboard 

o PDF dashboard document (Simple) 

o PDF dashboard document (Detailed) 

 

• Disable - All subscriptions marked as ‘disabled’ will not be delivered at the scheduled time. 
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13.4. Contacts and Contact Groups 
The 'Contacts' is a list of persons with their first name, last name, and email address that is shared by all 

application users. For Kyubit users who are preparing scheduled reports/dashboards to deliver by email to other 

individuals (often not even Kyubit users), contacts and contact groups can save a lot of time. Instead of adding 

the email address of each person to receive the email to the subscription, now the application supports creating 

contacts and contact groups for rapid subscription email setup. You can create a contact that is easily searched 

and added to every new subscription and not remember his email address for each new scheduled report. If a 

subscription contains multiple contacts to send to, it will be sent for each contact separately. 

  

 

 

The strongest feature is to create and manage contact groups, which can save a lot of time while preparing 

subscriptions for larger groups of people. For example, you can add 100 users to a group and quickly add it to 

every new subscription. 
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13.5. Recurring subscriptions 
To create a single subscription that would send multiple subscription emails during the same day, it is not 

necessary to create multiple subscriptions, but a single subscription that has enabled recurring options. To set 

recurring subscription execution, set ‘Recurring’ to enabled on the ‘Recurring’ tab, email frequency in minutes 

and ending time of the subscription recurring execution. 

 

 

 

 

13.6. Send subscriptions conditionally  
Dashboard subscriptions have ability to be sent conditionally. When the subscription condition is met the 

subscription is sent. 

 

The subscription condition is defined with value, criteria and Query/Analysis. When the first cell from the 

selected Query/Analysis meets the defined condition, the subscription will be sent. 
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13.7. Personalized Circular Subscriptions 
Creating a single dashboard subscription that has to be sent to many users (contacts) in a such way that each 

recipient (contact) receives the content (dashboard) personalized for him. This is achieved by applying 

dashboard filters that are related to 'User Properties'. Each contact can be assigned with ‘User Properties’ that 

holds values related to the him. Open the ‘Contacts’ entity to manage ‘User Properties’ for the particular 

contact. 
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14. Mobile Dashboards View 
All dashboards and the dashboard folders created within 'Kyubit Business Intelligence' web application are 

available to be used from mobile devices. A user is authorized to see exact same dashboard objects and data as 

within ‘Desktop view’ of the Kyubit application. Kyubit BI can be used internally to access data from mobile 

devices on the local intranet and wireless connection or Kyubit application can be exposed externally on the web 

and users can reach their business data, visualizations and analytics from anywhere. Prepared dashboards based 

on the SQL and OLAP data can be accessed using mobile devices and mobile user interface to visualize and 

analyze data in the real-time. Mobile BI with Kyubit software is accessible using modern web technologies 

(HTML5, CSS3) and mobile web browsers. 

 

 

 

14.1. Connect Mobile Device to Kyubit Business Intelligence 
To connect to Kyubit Business Intelligence and display created dashboards, simply open the web browser on 

your mobile device and type URL of your Kyubit BI web application. If your Kyubit web application is exposed on 

the internet, enter URL of the Kyubit app public web address and add '/Mobile/Index.html'  

(For example, http://yourkyubitaddress/mobile/index.html)  

 

To access Kyubit BI on the local intranet:  

1) Find your server IP address. (Command prompt -> IPCONFIG) 

2) Type URL to the mobile device browser together with the port number and /Mobile/Index.html (For 

example, http://10.2.203.166:81/Mobile/Index.html) 

3) The first time you will need to enter your Windows/Kyubit credentials to access the application. 
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12.2. OLAP Analysis on Mobile Dashboards 
Perform OLAP analysis Drill-Down and Drill-through actions to find more in-depth details of your data with the 

touch of your fingers from Dashboards Mobile view. Select OLAP dimension level to Drill the current data with 

multiple Drill-Down steps or get back to the previous state of analysis. Select predefined Drill-through actions 

that will return row details of the current OLAP visualization. 

1) Open the Dashboard with charts based on the OLAP data 

2) Touch the chart segment you would like to explore to discover new details (Drill). 

3) Select OLAP action: Drill-by, Drill-Down or Drill-Through. 

4) Select the OLAP dimension to drill. 

5) Select OLAP dimension hierarchy - level to drill 

6) The chart on the dashboards mobile view transforms to display drill-down dimension level. 

7) Repeat this step multiple times to reach analysis data of the interest. 

8) Select 'Back' to return to previous states of the OLAP analysis 
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All dashboard visualizations available at the dashboard design time will be rendered on mobile devices with all 

custom display options defined while designing the dashboard. Visual options and data settings like, Color 

Theme Pallets, Value Labels, Average/Trendlines and others will behave the same way on mobile and desktop 

view of the dashboard. For each dashboard tile, the user can select chart visualization and the option to 'Show 

Values' to see pure values that are base for the chart visualization. OLAP data chart visualizations have the 

option to 'Drill-Through' data for specific chart segment to see all leaf-level data details that are related to the 

chart segment of the interest. 
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15. Multipage Reports 
The ‘Multipage Report’ consist of more analyses and dashboards on the same report with tabs above the page to 

quickly switch from one analysis or dashboard to another. Multipage Report groups dashboards and analyses of 

common interest, so the users do not have to look for the related data on several different places on the portal. 

After you create Multipage Report, simply send the link to someone who will be able to see all related BI content 

without having to leave the page. 

To create a Multipage report, follow these steps: 

1) Click on a ‘New Multipage Report’ button 

2) Select analyses and dashboards to appear on the Multipage report 

3) Select order of appearance of Dashboards and Analyses 

4) Set Name and the Description for Multipage Report and Save it. 

5) Multipage Report is displayed in the Folder with Dashboards and could be shared with other users by 

moving to any shared folder. 
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16. Dashboard Data Slideshow 
Click the 'Slideshow' button that will start the full-screen dashboard slideshow querying data sources and 

presenting visualizations and metrics in the real-time. 

 

 

 

While designing Dashboard user set slides transition duration and caching options that could cache returned 

data and not query data sources for the same visualization for a defined time in minutes. All dashboard 

visualizations are transformed to full-screen mode during slideshow presentation, presenting only chart/metric 

data, dashboard tile title and description for the displayed visualization. Slideshow logic rotates all dashboard 

visualization one by one, repeating until slideshow page is closed. 

 

 

 

 



 

 

142 

Dashboards Tools and Features with Kyubit Business Intelligence - User documentation 

Dashboards Tools and Features with Kyubit Business Intelligence – User documentation 

17. Integrate dashboards with other web applications and 

sites 
The dashboard created within the Kyubit Business Intelligence application could be easily embedded/included in 

any HTML page using IFRAME element, allowing number of configuration options to customize dashboard 

appearance to best fit visually into existing HTML page. 

 

 

 

Simple example of embedded dashboard using IFRAME element: 

<iframe id="dashFrame" src="http://KyubitBI/Forms/Dashboard.aspx?DashboardID=3" width="800px" 

height="1000px" frameborder="0" scrolling="no"></iframe> 

 

Add IFRAME element and set SRC attribute to URL of the dashboard from the Kyubit Business Intelligence 

application (Same URL if opened from Kyubit Business Intelligence application). 

Additional URL attributes to customize dashboard appearance: 

▪ Align, alignment of the dashboard within IFRAME element 

▪ Font, dashboard fonts 

▪ FontColor, dashboard font color 

▪ TileFontSize, dashboard title size 

▪ HideDesignButton, hides ‘Design’ button 

▪ HideCloseButton, hides ‘Close’ button 
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▪ HideOpenPDFbutton, hides ‘Open PDF’ button 

▪ HideSubscribeButton, hides ‘Subscribe’ button 

Example with all attributes: 

<iframe id="dashFrame" 

src="http://KyubitBI/Forms/Dashboard.aspx?DashboardID=3&align=right&font=helvetica&fontColor=red&tileFo

ntSize=11px&hideDesignButton=1&hideCloseButton=1&hideOpenPDFbutton=1&hideSubscribeButton=1" 

width="800px" height="1000px" frameborder="0" scrolling="no"></iframe> 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


